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Introduction

This document is intended for new users of IBM® Cognos® Express®. IBM Cognos Express is a

simple, yet complete, solution that integrates all of the essential business intelligence and planning

features.

This guide provides an overview of IBM Cognos Express and will provide you with information

on how it is designed as well as get you started with using the features it contains.

Audience

To use this guide, you should be familiar with

● Basic Microsoft® Windows® tasks

● Reporting, analysis, and planning concepts

Finding information

To find IBM®Cognos® product documentation on the web, including all translated documentation,

access one of the IBM Cognos Information Centers at http://publib.boulder.ibm.com/infocenter/

cogic/v1r0m0/index.jsp. Updates to Release Notes are published directly to Information Centers.

You can also read PDF versions of the product release notes and installation guides directly from

IBM Cognos product disks.

Using Quick Tours

Quick tours are short online tutorials that illustrate key features in IBMCognos product components.

To view a quick tour, go to theWelcome to IBM Cognos Express page and click the Quick Tour
button in the lower-right corner of the page or access it from the Help menu in IBM Cognos Con-

nection.

Accessibility features

This product does not currently support accessibility features that help users with a physical disability,

such as restricted mobility or limited vision, to use this product.

Forward-looking statements

This documentation describes the current functionality of the product. References to items that are

not currently available may be included. No implication of any future availability should be inferred.

Any such references are not a commitment, promise, or legal obligation to deliver any material,

code, or functionality. The development, release, and timing of features or functionality remain at

the sole discretion of IBM.

Samples disclaimer

The Great Outdoors Company, GO Sales, any variation of the Great Outdoors name, and Planning

Sample depict fictitious business operations with sample data used to develop sample applications

Licensed Materials – Property of IBM
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for IBM and IBM customers. These fictitious records include sample data for sales transactions,

product distribution, finance, and human resources. Any resemblance to actual names, addresses,

contact numbers, or transaction values is coincidental. Other sample files may contain fictional

data manually or machine generated, factual data compiled from academic or public sources, or

data used with permission of the copyright holder, for use as sample data to develop sample appli-

cations. Product names referenced may be the trademarks of their respective owners. Unauthorized

duplication is prohibited.
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Chapter 1: What do I do with Express?

IBM®Cognos® Express® provides everything that you need to report, plan and analyze your company

data. IBM Cognos Express is designed for simplicity - we want to ensure that users like you can

access all the tools and features that you require from one central location.

IBM Cognos Express provides a self-service environment for the features and tools that come with

each Cognos Express product so that you can get up and running quickly in creating models, reports,

plans and views that will improve the performance of your business.

If you were given access by your administrator, you can use the following Express modeling tools:

❑ Data Advisor allows you to quickly connect to company data and create multi-dimensional or
relational models

❑ Architect allows you to create and manage cubes on the IBM Cognos Analytic Server.

Depending on which Express products your company purchased, you may also have access to the

following end user tools and applications:

❑ IBM® Cognos® Express® Reporter features Report Studio for reporting and Query Studio for

ad-hoc querying. Administrators can also use Framework Manager to create more complex

data models against one or many data sources that can then be used with these reporting tools.

❑ IBM® Cognos® Express® Advisor features the Advisor web client for analyzing data.

❑ IBM® Cognos® Express® Planner features Contributor for viewing and contributing plans

throughout the planning process. Administrators will first use the Planner Administrator tool

to set up these plans for end users to access.

❑ IBM® Cognos® Express® Xcelerator features the Xcelerator web client and the Excel-based

analysis tool.

What do I need to get started?

The Welcome page
The first stop for accessing IBM®Cognos® Express® content is theWelcome to IBMCognos Express

page. Your administrator can create a user account so that you are able to logon as well as provide

the link that you require to access this page - be sure to save it in your Favorites list for future use.

On the Welcome Page, you will see the following sections:

The My Content section

Use theMy Content section to open IBM Cognos Connection. You have these options:

● If you clickMy Home, IBM Cognos Connection will open at the page that you set as your

home page.

Licensed Materials – Property of IBM
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Tip: To set your home page, go to the page you want as your new home page, and then next

to the home icon , click the arrow, and click Set as Home Page.

● If you click IBM Cognos Content, IBM Cognos Connection will open at the top level of Public

Folders.

For more information, see the IBM Cognos Connection User Guide.

The My Actions section

Use theMy Actions section to perform IBM Cognos Express tasks that were enabled by the

administrator, start IBM Cognos Express products, download IBM Cognos Express client software

to your computer, or view Getting Started with IBM Cognos Express. Depending on what your

administrator has made available, you may have any of the following options:

● If you click Query my business data with Query Studio, Query Studio starts. For detailed
information, see the Query Studio User Guide.

If you just want to get started using Query Studio, see "Creating a report with Query Stu-

dio" (p. 35).

● If you click Create professional reports with Report Studio, Report Studio starts. For detailed
information, see the Report Studio Professional Authoring User Guide or the Report Studio

Express Authoring User Guide.

If you just want to get started using Report Studio, see "Creating a report with Report Stu-

dio" (p. 37).

● If you click Explore my data with Advisor, Advisor starts. For detailed information, see the
Advisor User Guide.

If you just want an overview of Advisor, see "Getting started with analysis" (p. 31).

● If you clickContribute to planning activities with Planner, Planner starts. For detailed informa-
tion, see the IBM Cognos Express Planner User Guide.

If you just want an overview of Planner, see "Getting started with planning" (p. 47).

● If you clickManage my business performance with Xcelerator, Xcelerator starts. For detailed
information, see the Xcelerator User Guide.

If you just want an overview of Xcelerator, see "Getting started with spreadsheet-based analy-

sis" (p. 41).

● If you clickDownload Express software to my computer, you can download the client software
that your administrator has made available.

For information, see "Installing client applications for IBM Cognos Express" (p. 11).

● If you click Read "Getting Started with IBM Cognos Express", the document Getting Started
with IBM Cognos Express displays.
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The Daily News section

Watch the Daily News section for updates on when a product is installed, client software is made

available, or a service is unavailable.

For example, the following message may appear in the Daily News section:

Architect 9.5 for IBM Cognos Express Manager is now available for download.

If you see the message above in the Daily News section and the administrator has assigned the
appropriate access to you, you can install Architect.

Note: To see the latest news, refresh your browser window.

Cognos Connection
Once you start creating reports and views, you will see that you can save much of your content to

the Cognos Connection portal for other users to access. In Cognos Connection, you can save content

● to the Public Folders tab where all other users can view it

● to your own tab namedMy Folders where the content is restricted to your own use

For example, you can use theMy Folders tab to create draft content, then move it to Public Folders
when you have finished working on it and are ready to share it with others.

Downloading client software
When you click on the link Download Express Software to my computer from the Welcome Page,

you will see a list of client software to which your administrator has provided you access. The

details for installing this software are included in more detail later in this guide (p. 11). However,

installation of these tools is designed to be fast and simple; all of the configuration will be taken

care of automatically when you download and install them from the Welcome Page.

Accessing Cognos Express Web tools
Similar to the client software, your access to the web applications that come with your IBM®Cognos®

Express® product(s) is controlled by your administrator. When you log on to the Welcome Page,

you will see the list of products that have been enabled for you to use in the My Actions section.

All of these applications can also be launched from the Launch menu at the top of your Cognos

Connection page.

Using the samples
IBM®Cognos® Express® comes with a set of samples that you can use to explore the various features

and functionality within the product. Your administrator will have to set these up for you on the

IBMCognos Express server. Once this is done, you can browse the predefined set of reports, queries

and views that are available in Cognos Connection or view the cubes and dimensions that are

available on the IBM Cognos Analytic Server. Many of the tutorials that you will find for each of

the products in this guide use these samples as a starting point.
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Can I see a diagram?
The following diagram shows the architecture of IBM® Cognos® Express®.
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Chapter 2: Installing client applications for IBM
Cognos Express

Depending on which IBM® Cognos®Express® roles were assigned to you by your administrator,

you can do one or more of the following:

❑ Install IBM® Cognos® Express® Data Advisor.

❑ Install IBM® Cognos® Express® Architect.

❑ Install IBM® Cognos® Framework Manager, the client application used with Reporter.

❑ Install IBM® Cognos® Xcelerator client, the client application used with Xcelerator.

❑ Install IBM® Cognos® Planner Administrator, the client application used with Planner.

The Welcome to IBM Cognos Express page

If you don't already know the Web address for the Welcome to IBM Cognos Express page, ask
your administrator to give it to you.

Tip: The Web address is usually the following:

http://express_server_name:19300/cognos_express/manager/welcome.html

where express_server_name is the computer name of the IBM® Cognos® Express® server.

Installing and Launching IBM Cognos Express Data Advisor
You install IBM®Cognos®Express® Data Advisor from theWelcome to IBMCognos Express page.

Before you install Data Advisor:

● You must install Microsoft® .NET Framework version 3.5 SP1

● Your administrator must give you access to download the software

Tip: It is good practice to read the messages in the Daily News section (p. 9) regularly. You will

know that you can install Data Advisor when you see this message:

The Data Advisor download for IBM Cognos Express Advisor is now available.

Steps

1. In a browser window, go to theWelcome to IBM Cognos Express page.

Tip: The Express administrator should send you theWeb address, which is usually the following:

http://express_server_name:19300/cognos_express/manager/welcome.html

where express_server_name is the computer name of the IBM® Cognos® Express® server.

2. Select Download Express software to my computer.

Licensed Materials – Property of IBM
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3. Select Data Advisor and run the installation wizard.

4. When the Install Complete page displays, select Launch Advisor.

You can now make a connection to a package or a cube (p. 12).

For more information, see the IBM Cognos Express Advisor User Guide.

Making connections
For both new and existing views, you must make a connection to a package and a valid cube for

the view.

Steps for a new view

1. Click Views button on the toolbar tab.

2. Select a view or folder and clickOpen View. If you click onOpen Viewwhen a folder is selected,

all views in the folder are opened.

3. Select a Package from the Database list on the Connection Information window and click OK.
If there is more than one cube in the package, select the cube.

Note: Local Views will not be available when you use Advisor on Microsoft® Windows® Vista

with Microsoft® Internet Explorer 7 running in protected mode.

4. In the Credentialswindow, enter your IBM Cognos security credentials to access the server and

click OK.

Steps for an existing view

1. Click on the Connection button on the toolbar to connect to a different cube or package.

2. On the Connection Information window, select the cube or package to change the connection
to the server.

3. To clear the credentials, including passwords, for the server, click Forget Credentials.

Configuring the ODBC data source
The ODBC data source must be configured identically on the Advisor Server system and on an

Express Data Advisor client system. The ODBC data source for both the Advisor server and the

Express Data Advisor client must have the same name and must link to the same relational database.

The Express administrator must make sure that the configuration of the client system and the ODBC

data source is exactly the same.

Configuring the ODBC data source for Express Data Advisor on the client system

You must configure the ODBC data source for Express Data Advisor on the client system.

Steps

1. Check that the Advisor Server is configured. The Advisor Server must be configured before you

can configure your computer.
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2. Click Start > Control Panel.

3. Select Administrative tools > Data Sources (ODBC).

4. From the ODBC Data Source Administrator dialog box, select the System DSN tab.

5. Select Add.

The Create New Data Source dialog box opens.

6. From the drop-down menu, select the data source driver.

7. Click Finish.

The Create New Data Source dialog box for the driver type opens.

8. Complete the on-screen instructions for the driver type. The fields that are required to be

completed are dependant on the data source type. Make sure that the naming convention is

the same as given by the system administrator on the server.

The data source name must the same on both the server and the client system.

9. Click OK until all dialog boxes close.

Configuring the ODBC data source for Express Data Advisor on the server

Important: Check that the Express administrator follows the steps below to configure the ODBC

data source for Express Data Advisor on the server. The procedure on the server is slightly different

than the procedure on the client.

A 64-bit server requires that the ODBC data sources must be 32-bit. To do this you should use the

32-bit data sources application.

Steps

1. Click Start > Run.

2. In the open field, type %WINDIR%\SysWOW64\odbcad32.exe

3. Click OK to launch the 32-bit data sources application.

4. From the ODBC Data Source Administrator dialog box, select the System DSN tab.

5. Select Add.

The Create New Data Source dialog box opens.

6. From the drop down-menu, select the data source driver.

7. Click Finish.

The Create New Data Source dialog box for the driver type opens.

8. Complete the on-screen instructions for the driver type. The fields that are required to be

completed are dependant on data source type, but may include:

● Data source name - Required

● Data source description
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● Data source server

● Data source address

Note: The data source name must be identical on both the server and the client system.

9. Click OK until all dialog boxes close.

Uninstalling IBM Cognos Express Data Advisor
You can uninstall Data Advisor from your computer. Uninstalling removes Data Advisor from your

computer only.

Note: If your administrator uninstalls Reporter on the Express server, your instance of Data Advisor
will no longer work.

Steps

1. From the Start menu, click Settings > Control Panel.

2. Start Add or Remove Programs.

3. In the list of currently installed programs, click IBM Cognos Express Data Advisor.

4. Click Remove and follow the instructions.

Installing Architect
You install IBM® Cognos®Express® Architect from theWelcome to IBM Cognos Express page.

Before you install Xcelerator client:

● You must install Microsoft® Office Professional Edition 2003, 2007, or XP

● Your administrator must give you access to download the software

Tip: It is good practice to read the messages in the Daily News section (p. 9) regularly. You will
know that you can install Architect when you see this message:

The Architect download for IBM Cognos Express Xcelerator is now available.

Steps

1. In a browser window, go to theWelcome to IBM Cognos Express page.

The Web address is usually the following:

http://express_server_name:19300/cognos_express/manager/welcome.html

where express_server_name is the computer name of the IBM® Cognos® Express® server.

2. Download the installation package.

● Click Download Express software to my computer .

Tip: If this link is not available, your administrator has not yet assigned your Express userid
to the Express Architect User role.
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● Click Architect.

● Click Save, choose a location to save the installation package, then click Save again.

Important: Do not change the filename of this installation package.

The Download complete dialog displays.

3. Click Run.

4. Click OK to confirm that the product language is English.

5. In the installation wizard, do the following:

● On the Introduction page, click Next.

● Read the license agreement, click I accept both the IBM and the non-IBM terms, and then

click Next.

● If you want Architect to be installed in a location other than the one shown, browse to the

location you want.

● Click Next.

● Choose your preferred method for starting Architect.

● Click Next.

6. Click Install.

7. When the Install Complete page displays, select Launch Architect, and then click Done.

Architect starts in a new window.

You can now use Architect to create a new project, view data sources in IBM Cognos Connection,

create a new package, or publish a package to the IBM Cognos Connection.

For more information, see the IBM Cognos Express Xcelerator User Guide.

Uninstalling Architect
You can uninstall Architect from your computer. Uninstalling removes Architect from your computer

only.

Steps

1. From the Start menu, click Settings > Control Panel.

2. Start Add or Remove Programs.

3. In the list of currently installed programs, click IBM Cognos Express Architect.

4. Click Remove and follow the instructions.
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Installing Framework Manager
You install IBM® Cognos® Framework Manager from theWelcome to IBM Cognos Express page.

Install FrameworkManager if you want to model your company data and make packages available

to others users with which they can create reports. You do not need to perform any additional

configuration to begin using Framework Manager.

Before you download Framework Manager, your administrator must first

● ensure that you have an Express administrator license

● assign the Framework Manager Users role to you

Tip: It is good practice to read the messages in the Daily News section (p. 9) regularly. You will
know that you can install Framework Manager when you see this message:

The Framework Manager download for IBM Cognos Express Reporter is now available.

Steps

1. In a browser window, go to theWelcome to IBM Cognos Express page.

The Web address is usually the following:

http://express_server_name:19300/cognos_express/manager/welcome.html

where express_server_name is the computer name of the IBM® Cognos® Express® server.

2. Download the installation package.

● Click Download Express software to my computer.

Tip: If this link is not available, your administrator has not yet assigned your Express userid
to the Framework Manager User role.

● Click Framework Manager .

● Click Save, choose a location to save the installation package, then click Save again.

Important: Do not change the filename of this installation package.

The Download complete dialog displays.

3. Click Run.

4. Click OK to confirm that the product language is English.

5. In the installation wizard, do the following:

● On the Introduction page, click Next.

● Read the license agreement, click I accept both the IBM and the non-IBM terms, and then

click Next.

● If you want IBM Cognos Framework Manager to be installed in a location other than the

one shown, browse to the location you want.

● Click Next.
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● Choose your preferred method for starting IBM Cognos Framework Manager.

● Click Next.

6. Click Install.

7. When the Install Complete page displays, select Launch Express Framework Manager, and

then click Done.

Framework Manager starts in a new window.

You can now use Framework Manager to create a new project, view data sources in IBM Cognos

Connection, create a new package, or publish a package to the IBM Cognos Connection.

For more information, see the Framework Manager User Guide by clicking Contents from the

Framework Manager Help menu.

Uninstalling Framework Manager
You can uninstall Framework Manager from your computer. Uninstalling removes Framework

Manager from your computer only.

Before you uninstall Framework Manager, you should back up your Framework Manager projects

and models. This prevents the loss of your data should your computer be damaged or stolen. After

your computer is operational, you can restore your data. If you use a source control system to store

your Framework Manager projects, you do not need to back up your projects.

Note: If your administrator uninstalls Reporter on the Express server, your instance of Framework
Manager will no longer work.

Steps

1. From the Start menu, click Settings > Control Panel.

2. Start Add or Remove Programs.

3. In the list of currently installed programs, click IBM Cognos Framework Manager.

4. Click Remove and follow the instructions.

Installing Xcelerator client
You install IBM® Cognos®Express® Xcelerator client from theWelcome to IBM Cognos Express

page.

You do not need to perform any additional configuration to begin using the Xcelerator client.

Before you install Xcelerator client:

● You must install Microsoft® Office Professional Edition 2003, 2007, or XP

● Your administrator must give you access to download the software

Tip: It is good practice to read the messages in the Daily News section (p. 9) regularly. You will

know that you can install Xcelerator client when you see this message:
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The Xcelerator client download for IBM Cognos Express Xcelerator is now available.

Steps

1. In a browser window, go to theWelcome to IBM Cognos Express page.

The Web address is usually the following:

http://express_server_name:19300/cognos_express/manager/welcome.html

where express_server_name is the computer name of the IBM® Cognos® Express® server.

2. Download the installation package.

● Click Download Express software to my computer .

Tip: If this link is not available, your administrator has not yet assigned your Express userid
to the Express Xcelerator Client User role.

● Click Xcelerator client.

● Click Save, choose a location to save the installation package, then click Save again.

Important: Do not change the filename of this installation package.

The Download complete dialog displays.

3. Click Run.

4. Click OK to confirm that the product language is English.

5. In the installation wizard, do the following:

● On the Introduction page, click Next.

● Read the license agreement, click I accept both the IBM and the non-IBM terms, and then

click Next.

● If you want Xcelerator client to be installed in a location other than the one shown, browse

to the location you want.

● Click Next.

● Choose your preferred method for starting Xcelerator client.

● Click Next.

6. Click Install.

7. When the Install Complete page displays, select Launch Xcelerator client, and then click Done.

Xcelerator starts in a new window.

If you want to install TM1 Workflow for Xcelerator, follow these steps:

1. Go to the Xcelerator_client_installation_location/Workflow folder

2. Extract the zip file.

If you are on a 32-bit operating system, extract the file containing the characters x86
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If you are on a 64-bit operating system, extract the file containing the characters x64

3. Run the Workflow setup.exe file.

For more information, see "Installing TM1 Workflow" in the IBM Cognos Express Xcelerator

Installation Guide.

You can now use Xcelerator to create a new project, view data sources in IBM Cognos Connection,

create a new package, or publish a package to the IBM Cognos Connection.

For more information, see the IBM Cognos Express Xcelerator User Guide.

Uninstalling Xcelerator client
You can uninstall Xcelerator client from your computer. Uninstalling removes Xcelerator client

from your computer only.

Note: If your administrator uninstalls Xcelerator on the Express server, your instance of Xcelerator
client will no longer work.

Steps

1. From the Start menu, click Settings > Control Panel.

2. Start Add or Remove Programs.

3. In the list of currently installed programs, click IBM Cognos Express Xcelerator client.

4. Click Remove and follow the instructions.

Installing Planner Administrator
Install IBM®Cognos® Express® Planner Administrator to set up contribution workflows for planning

activities.

Note: To install Planner Administrator, you follow a different process than when you install the

other Express client applications. You do not download Planner Administrator from the Welcome

page. Instead, you start the Express Planner server product and download it from there.

If you are not the Express administrator, before you can download and install Planner Administrator,

the Express administrator must

● ensure that you have an Express administrator license

● assign Express Planner Administrator privileges to you

Steps

1. In Express Manager, from the Launch menu, click Planner.

2. In the Planner Contributor window, click the Design an Application button.

3. Click Install Now.

4. Run the file CognosRCP.msi
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The IBM Cognos Rich Client Framework is installed.

5. Restart your browser.

6. Repeat steps 1 and 2.

The installation finishes and Planner Administrator starts.

For information on using Planner Administrator, see the IBMCognos Express PlannerAdministration

Guide.

Uninstalling Planner Administrator
You can uninstall IBM®Cognos® Express® Planner Administrator from your computer. Uninstalling

removes Planner Administrator from your computer only.

Before you uninstall Planner Administrator, you should back up your Planner Administrator content.

This prevents the loss of your Planner Administrator data should your computer be damaged or

stolen. After your computer is operational, you can restore your data.

Note: If your administrator uninstalls Planner on the Express server, Planner Administrator will
no longer work.

Steps

1. From the Start menu, click Settings, Control Panel.

2. Start Add or Remove Programs.

3. In the list of currently installed programs, click IBM Cognos Rich Client Framework.

4. Click Remove and follow the instructions.

Planner Administrator is removed from your computer.
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Chapter 3: Getting started with modeling

IBM® Cognos®Express® allows you to easily create both basic and advanced models for accessing

your data.

The IBM Cognos Express Modeling tools - Data Advisor,
Architect, and Framework Manager

IBM® Cognos®Express® contains three modeling tools, each with different capabilities.

❑ IBM® Cognos® Express® Data Advisor allows you to create multi-dimensional based model

definitions and relational model definitions. Express Data Advisor Server generates multi-

dimensional packages and relational packages with these model definitions.

You can use these packages to analyze your data in IBM® Cognos® Express® Advisor and IBM®

Cognos®Express® Query Studio.

❑ IBM® Cognos® Architect allows you to connect to an IBM® Cognos® Analytic Server (ICAS),

which acts as a repository for IBM® Cognos®Express® Xcelerator objects and data. If you have

the proper administrative authority, then you can create and maintain cubes, dimensions, and

processes that can be made available to other users.

❑ IBM® Cognos® Framework Manager allows you to create advanced relational models. You

can then publish the models as packages to IBM® Cognos® Connection. If you install IBM®

Cognos® Express® Reporter, you can use Report Studio and Query Studio to report on your

published packages.

IBM® Cognos®Express® Data Advisor is aimed at knowledgeable business users to perform basic

multi-dimensional and relational modeling tasks. Creating advanced multi-dimensional models is

the realm of IBM® Cognos® Architect whereas advanced relational models can be created using

IBM® Cognos® Framework Manager.

Basic modeling
IBM® Cognos® Express® Data Advisor enables you to use relational data for analysis purposes by

creating a model definition that is either multi-dimensional based or based on relational tables.

With this model definition, the Express Data Advisor Server generates either a cube or a relational

package.

Before you can create and then configure a model definition, you must

❑ ensure that the ODBC data source is configured identically on the Express server and on your

Express Data Advisor client computer

❑ install IBM® Cognos®Express® Data Advisor
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Creating a model definition in IBM Cognos Express Data Advisor
To create a model definition you must connect to an available ODBC data source. To create an

ODBC data source, contact your system administrator. For more information, see "Configuring

an ODBC data source" (p. 26).

Note:You can change properties after creating the model definition by clicking theModel Definition

properties icon .

Steps

1. Click the New Model Definition icon .

2. In the General tab of the New Model Definition dialog box specify the following properties.

● Name

This is the name of your model definition. This will also be the file name when you save a

model definition.

● Data Source

The available tables from the ODBC data sources that are defined on your system display.

Select the ODBC data source that you want to use in your model definition.

● Package

This option allows you to store the package in the Public Folders or in the My Folders in
the content store.

Only authorized users can access the Public Folders in the content store. Only you are

authorized to access theMy Folders. You can store packages in either the Public Folders

or theMy Folders of the content store.

● Model

Specify whether you want to create a multi-dimensional (OLAP) based model definition

or a relational model definition.

3. In the Advanced tab of the New Model Definition dialog box select

● Client based to use the ODBC data source from the client system.

● Server based to use the enterprise wide ODBC data source.

This property only applies to multi-dimensional model definitions.

Note: You can change properties after creating the model definition by clicking the Model

Definition properties icon .

Configuring a model definition in IBM Cognos Express Data Advisor
The model definition is the basis for accessing your relational data. After you use IBM® Cognos®

Express®Data Advisor to configure a model definition, you can analyze your data in IBM®Cognos®

Express® Advisor or create reports on your data in IBM® Cognos® Query Studio.
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For more information, see the Express Advisor user guide, and the Query Studio user guide .

Selecting data

The Select Data pane allows you to select the tables you are interested in. You can disable and

enable tables individually. Alternatively you can disable and enable tables collectively by right-

clicking in the Select Data pane, outside a table, and selecting the appropriate command.

The contents of a table can be previewed by clicking the Show Table preview icon .

Creating relationships

If relationships are not predefined in your data source, you can create relationships by dragging a

field from a table and dropping it on another field.

Creating dimensions

Dimensions are only available in multi-dimensional model definitions. By default two dimensions

are present. The Values dimension is mandatory and the Time dimension is optional.

Drag and drop the appropriate fields on the Values dimension and the Time dimension.

Create additional dimensions by dragging and dropping fields in the Create Dimensions pane.

Create hierarchies by adding additional levels to a dimension.

The contents of a table can be previewed by clicking the Show Dimension preview icon .

Advanced modeling
IBM® Cognos® Express® supports advanced modeling tasks:

❑ You can create a cube in IBM® Cognos® Architect.

❑ You can use IBM® Cognos® Framework Manager to create models or packages.

Creating a cube in Architect
There are two ways to create cubes:

● Empty Cube - Select from a list of existing dimensions in the Creating Cube window to create

a new cube with no data.

● External Data Sources - Use TurboIntegrator to identify and map dimensions and data from

an external data sources to a new or existing cube.

This section documents creating cubes in theCreating Cubewindow. For information about creating
cubes in TurboIntegrator, see the IBM® Cognos®Analytic Server TurboIntegrator Guide.

Ordering Dimensions in a Cube

Dimensions in a cube have an order that you select when you create a cube. The order you select

can affect system performance, so you should give some consideration to the order of dimensions

before creating a cube.
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As a first step toward ordering dimensions, divide the dimensions into two groups: sparse and dense

dimensions. A dense dimension has a high percentage of values for its elements. You can estimate

the density by answering this question: If one element in the dimension has a value, keeping the

elements of the other dimensions constant, what is the probability that the other elements in the

dimension have values?

For example, if you have a budget in January for a given account and region, you probably also

have a value for the remaining months. Therefore, the Month dimension is probably dense.

However, in a worldwide sales cube, you probably do not sell every product in every region.

Therefore, you would treat Product and Region as sparse dimensions.

We generally recommend that you order the dimensions as follows: smallest sparse to largest sparse,

followed by smallest dense to largest dense.

Creating a Cube

Follow these steps to create a cube.

Steps

1. Click Start, All Programs, IBM Cognos Express, Architect.

2. In the Server Explorer, click the + next to Servers to reveal the IBM Cognos Analytic Servers

that are available on your network.

3. Double-click the server on which you want to create a cube..

4. On the login screen, enter your User ID and Password, then click OK.

5. Click Cubes, Create New Cube.

The Creating Cube dialog box opens. The Available Dimensions box on the left lists the
dimensions stored on the server.

6. Type a cube name in the Cube Name field.

7. In the Available Dimensions box, double-click the name of the dimension you want to use as

the first dimension in the new cube.

The dimension name moves to the Dimensions in new cube box.

You can also use the arrow button to move selected names from the Available Dimensions box

to the Dimensions in new cube box. To select multiple adjacent names, click and drag across
the names. To select multiple non-adjacent names, hold down CRTL, and click each name.

8. Repeat the selection process for all the dimensions you want to include in the new cube. You

must select at least two dimensions. The maximum number of dimensions is 256.

9. Using the up and down arrows, rearrange the dimensions if necessary. To remove a dimension

from the list, double-click the dimension name.

10. If you want to specify the cube properties, click Properties. If you do not want to assign cube

properties, skip to step 13.

The Cube Properties dialog box opens.
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From here, you can set a Measures and Time dimension for the cube, and specify if the cube

is loaded automatically or on demand.

Note: OLE DB for OLAP clients may include provisions for referencing Measures and Time

dimensions. Xcelerator does not reference Measures and Time dimensions, but does allow you

to set these properties for other OLAP clients that may access the cube.

11. To set a Measures dimension, select a dimension from the Measures Dimension list.

12. To set a Time dimension, select a dimension from the Time Dimension list.

13. Specify how to load the cube:

● To load the cube into server memory only when a client requests cube data, select the Load

On Demand box.

● To automatically load the cube into memory when the server starts, clear the Load On

Demand box.

14. Click OK to save the properties and return to the Creating Cube dialog box.

15. Click Create Cube to create the cube.

The Server Explorer window opens. The new cube displays in alphabetical order in the Cubes
list.

Creating or modifying a model in IBM Cognos Framework Manager
After you install Framework Manager, use it to create or modify models and to publish packages

if this is a function that you will perform in your organization.

Because stored data is typically designed for storage and not for reporting, a model allows you to

structure, add to, and manage data in ways that make sense to business users. For example, a model

defines business rules, data descriptions, data relationships, business dimensions and hierarchies,

and administrative tasks.

A package contains all the information that a specific user or group of users needs to create reports.

For example, one package can contain human resources data, and another sales data. When you

open an authoring studio, you must select which package to use. Each report can contain data from

only one package.

This section does not include instructions for modeling data in FrameworkManager. For information

about how to use Framework Manager, see the Framework Manager User Guide and Guidelines

for Modeling Metadata that accompany Framework Manager.

Tutorial - basic modeling
In this tutorial you use samples. To install the samples, see the Managing IBM Cognos Express

guide, Setting up the IBM Cognos Express samples.

To create model definitions with IBM® Cognos® Express® Data Advisor, you must configure an

ODBC data source.
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Note: You must perform the procedures in this tutorial on the IBM® Cognos® Express® Server.

Configuring an ODBC data source
To create a model definition, the administrator must first configure the ODBC for IBM® Cognos®

Express® Data Advisor.

Steps

1. Click Start > Control Panel.

2. Double-click Administrative tools > Data Sources (ODBC).

Note: A 64-bit client system requires 32-bit ODBC data sources. Use the 32-bit data sources

application. Click Start > Run and type:

%WINDIR%\SysWOW64\odbcad32.exe

3. On the ODBC Data Source Administrator dialog box, select the System DSN tab and click

Add.

4. In the Create New Data Source dialog box, from the menu, select the IBM INFORMIX ODBC

data source driver, and click Finish.

5. In the IBM ODBC Driver Setup dialog box, on the General tab, specify great_outdoors_

sales in the Data Source Name field.

On the Connection tab, from the Database Name menu, select gosales.

6. Click OK until all dialog boxes close.

Creating a cube in IBM Cognos Express Data Advisor and analyzing the data in
Express Advisor

With IBM® Cognos® Express® Data Advisor you can create a multi-dimensional model definition.

You can use this model definition for creating a package that contains a cube. You can analyze

your data by creating a view, that is based on the cube, in IBM® Cognos® Express® Advisor.

Steps for creating the multi-dimensional model definition

1. Start Express Data Advisor.

2. In the New Model Definition dialog box specify the following on the General tab:

● For the Name type GoSalesCube

● As the Data Source select great_outdoors_sales

● For Package select Store in my folder.

● For Model select OLAP.

On the Advanced tab, forModel generation, specify the option Client based.
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3. Click OK.

Steps for configuring the multi-dimensional model definition

1. On the Select Data pane, only select the order_details and order_header tables from the gosales

schema.

2. Open the Define Relationships pane.

3. From the order_details table, drag and drop the order_number to the order_number column

in the order_header table.

4. Open the Create Dimensions pane.

5. From the order_details table, drag and drop the quantity column in the Values dimension.

6. From the order_details table, drag and drop the ship_date column in the Time dimension.

7. You can choose to create and analyze the cube, or to just create the cube.

Either

● Click the Create and Analyze Cube icon .

Express Advisor starts and displays the view. You can now analyze your data with this

view. For information on analyzing your data with Express Advisor, see "Tutorial - analyz-

ing a cube in IBM Cognos Express Advisor" (p. 32).

or

● Click the Create Cube icon .

The package is created.

Steps for opening the multi-dimensional package in Express Advisor

1. Start IBM Cognos Connection.

2. On theMy Folders tab clickMy Folders > Advisor Packages > GoSalesCube.

3. Click the Default Analysis package.

Express Advisor starts and displays the view. You can now analyze your data with this view.

For information on analyzing your data with Express Advisor, see "Tutorial - analyzing a cube

in IBM Cognos Express Advisor" (p. 32).
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Creating a relational package in IBM Cognos Express Data Advisor and using the
data in IBM Cognos Query Studio

With IBM® Cognos® Express® Data Advisor you can create a relational model definition. You can

use this model definition for creating a package. You can use this package to analyze your data in

IBM® Cognos® Query Studio.

Steps for creating the relational model definition

1. Start Express Data Advisor.

2. In the New Model Definition dialog box specify the following on the General tab:

● For the Name type GoSales

● As the Data Source select great_outdoors_sales

● For Package select Store in my folder.

● For Model select Relational.

3. Click OK.

Steps for configuring the relational model definition

1. On the Select Data pane, only select the order_details and order_header tables from the gosales

schema.

2. Open the Define Relationships pane.

3. From the order_details table drag and drop the order_number to the order_number column in

the order_header table.

The Relationship Properties dialog box appears.

4. Verify that one is selected for the order_header and that one or many is selected for the
order_details table.

This means each order header has one or more order details.

5. You can choose to create and use the model, or to just create the model.

Either

● Click the Create and Use Model icon .

Query Studio starts. You can now analyze your data and create reports. For more informa-

tion on using Query Studio, see "Tutorial - querying a package in Query Studio" (p. 38).

or

● Click the Create Model icon .
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The package is created.

Steps for opening the relational package in Query Studio

1. Start IBM Cognos Connection.

2. On theMy Folders tab clickMy Folders > Advisor Packages > GoSales.

3. From the Launch menu, select Query Studio.

Query Studio starts. You can now analyze your data and create reports. For more information

on using Query Studio, see "Tutorial - querying a package in Query Studio" (p. 38).

Tutorial - creating an ICAS cube in Architect
An IBM®Cognos®Analytic Server (ICAS) cube must contain at least two dimensions and can contain

as many as 256 dimension. For this example, you create a cube with four dimensions that define

the products your company sells through various channels across all months in a year. The cube

uses the following dimensions:

● Channels

● Months

● Products

● Sales Plan Measures

The final dimension, Sales PlanMeasures, may not seem like an obvious choice. However, a separate

measures dimension gives your cubes the ability to adapt to change in the future. Including a measures

dimension in every cube means that you can simply add additional measures to that dimension as

your business requirements evolve.

Steps

1. Click Start, All Programs, IBM Cognos Express, Architect.

2. In the Server Explorer, click the + next to Servers to reveal the IBM Cognos Analytic Servers

that are available on your network.

3. Double-click cxmd.

4. On the login screen, enter your User ID and Password, then click OK.

5. In the Server Explorer, right click Cubes, then click Create New Cube.

The Creating Cube dialog box appears.

6. In the Available Dimensions list, double-click each of the following dimensions, in order:

● Months

● Sales Plan Measures

● Channels
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● Products

The dimensions are added to the Dimensions in new Cube list.

Note: If you make a mistake, click the Reset button to start over.

7. After selecting your dimensions, click in the Cube Name field and enter Tutorial Cube as the

cube name.

8. Click Create Cube.

9. In the Server Explorer, click the + next to the Cubes group to reveal all the cubes on the server.

Tutorial Cube should appear in this list of cubes.
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Chapter 4: Getting started with analysis

IBM® Cognos®Express® Advisor allows you to perform flexible multi-dimensional analysis.

The Express analysis tool - Advisor
IBM®Cognos®Express®Advisor helps you to understand your data in new ways and from different

perspectives. You can customize reports or use Express Advisor to do dynamic analyses of results

that are important to the decision-making process.

Features of IBM Cognos Express Advisor
With Express Advisor you can:

● Create dashboards

● Change selections

● Change the position of dimensions

● Format your data

● Create calculations

● Show data in tabular and graphical formats

● Print reports and views of your data

● Export your data to Microsoft® Excel spreadsheets

See the Express Advisor user guide for detailed information.

Analyzing your data in IBM Cognos Express Advisor
IBM® Cognos® Express® Advisor accesses cube data through a package. If your data is already

available in a cube, you can use IBM® Cognos® Express® Manager or IBM® Cognos® Framework

Manager to create a package for that cube. If your data is not available in a cube, you can use IBM®

Cognos® Express® Data Advisor to create both the cube that contains your data and a package for

the cube.

Starting IBM Cognos Express Advisor from IBM Cognos Express Data Advisor
You can start IBM®Cognos® Express®Advisor from IBMCognos Express Data Advisor. Depending

on the complexity of your analysis definition and the relational data source, this may take some

time.
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The first time you start Express Advisor you will be asked to install it.

Step

● With an analysis definition open in Express Data Advisor, click the Create and Analyze Cube

icon .

Express Advisor starts with a view that is based on your analysis definition.

Starting IBM Cognos Express Advisor from IBM Cognos Express Welcome page
If an existing database in a package (cube) is already available, you can start using Express Advisor

from Express Manager.

The first time you start Express Advisor you will be asked to install it.

For more information see the IBM Cognos Express Advisor User Guide.

Steps

1. In IBM Cognos Express Manager click Launch > Advisor.

2. On the toolbar, click the Views button .

3. Select a package and click New View.

4. Select a database from the package and click OK.

Starting IBM Cognos Express Advisor from IBM Cognos Express Manager
If an existing database in a package (cube) is already available, you can start using Express Advisor

from Express Manager.

The first time you start Express Advisor you will be asked to install it.

For more information see the IBM Cognos Express Advisor User Guide.

Steps

1. In IBM Cognos Express Manager click Launch > Advisor.

2. On the toolbar, click the Views button .

3. Select a package and click New View.

4. Select a database from the package and click OK.

Tutorial - analyzing a cube in IBM Cognos Express Advisor
In this tutorial you use samples. To install the samples, see theManaging IBM Cognos Express

guide, Setting up the IBM Cognos Express samples
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To use the samples in IBM® Cognos® Express® Advisor you must create a package.

Steps for creating a package for Express Advisor

1. Open the IBM Cognos Express Manager page.

2. Click the Data tab in the Administration section.

3. Click Add.

4. Specify the following:

● Data Source Type:TM1

● Name:Sales Plan Tutorial

● Admin Host: <Express Server>

Specify the name of your Express server.

● ICAS Server Name: CXMD

● Cube Name: Sales Plan

● Namespace: CognosExpress

5. Click OK.

Steps for analyzing a cube in Express Advisor

1. Open theWelcome to IBM Cognos Express page.

2. Click Analyze my Business with Advisor.

3. Click the package Sales Plan Tutorial.

Express Advisor starts.

4. Click the Views button on the toolbar tab.

5. On the Public Folders tab, click the Sales Plan package icon .

6. Click New.

7. Select View.

8. Type the name of the new view.

9. Click Open.

In the Connection Information dialog box, the package Sales Plan Tutorial is already selected.

10. From the Database menu, select the Sales Plan database and click OK.

You can now analyze your data in the view you created.
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Chapter 5: Getting started with reporting

IBM® Cognos® Express® Reporter allows you to perform ad-hoc queries on your company data

and to create professional reports for distribution to other users. The starting point for IBMCognos

Express Reporter is a self-service Web portal where you can view and store IBM Cognos Express

Reporter content.

You can download to your computer an additional application called Framework Manager. This

application allows you to model your company data and make packages available to other users

who can then use the packages to create reports.

The tasks in this section help you to start using IBM Cognos Express Reporter and provide an

overview of the various applications that are available to you.

The Express reporting tools - Report Studio and Query Studio
IBM® Cognos®Express® Reporter contains two tools for creating and querying reports.

❑ IBM® Cognos® Report Studio allows you to author reports that analyze corporate data

according to specific business needs.

❑ IBM® Cognos® Query Studio allows you to create self-service business intelligence reports.

Launching IBM Cognos Express
If you don't already know the Web address to launch IBM® Cognos® Express®, ask your adminis-

trator to provide it to you.

The Web address to launch the Welcome page is usually as follows:

http://express_server_name:19300/cognos_express/manager/welcome.html, where

express_server_name is the computer name of the IBM Cognos Express server.

Creating a report with Query Studio
The following steps will help you to create a simple report in Query Studio and will highlight some

of the features that are available. In Query Studio, with minimal steps, you can view data, author

basic reports, change the report layout, filter and sort data, add formatting, and create charts.

❑ Open Query Studio.

On the IBM® Cognos® Express® Welcome page, click Query my business data with Query

Studio. You must select a package before you can continue. You can select a package that your
administrator or another user published or a package that you created with FrameworkManager.

❑ Select data for your report.

In Query Studio, under Insert Data on the left side menu, browse the data tree and find the

items that you want to include in your report.

Licensed Materials – Property of IBM
35© Copyright IBM Corp. 2009, 2011.



❑ Add data to your report.

Double-click the data items you want to add or drag them to the empty report on the right side

of your screen. To remove items, select them and click the delete button . To rename items,

double-click the title area and type the new title. To move items, drag them to a new position

in the report.

❑ Group data.

To group data, select the columns that you want to group and click the group button . If

your report includes measures, notice that summaries, such as totals and subtotals, are added

automatically.

❑ Format data.

To format data, right-click a cell in the report and click Format Data. For example, you can
change the number of decimal places or add a currency symbol.

You can also change the appearance of your report with the buttons on the style toolbar. For

example, you can add color or change the font.

❑ Filter data.

To narrow the focus of your report to one or more data items, select the column that contains

the items that you want to use to filter and click the filter button (or right-click and select

Filter).

This opens a new screen that allows you to select only the data items that you want in your

report. For example, include data for only a specific year or product line.

❑ Add a chart.

To add a visual representation of your data to the report, on the standard toolbar, click the

chart button . You see a list of available chart options to add to your report. Choose the

one that best suits the data that you want to represent. Data is automatically plotted on the

chart. To change the chart type, repeat this process.

❑ Save the report.

To save your report, click the save button . Provide a name for your report and select a

location in IBM Cognos Connection to save your report. Save your report in Public Folders to

make it available to others. Save it inMy Folders to make it available only to yourself. To

change the default location, click Select another location.

Tip: By default, you cannot save reports at the top level of IBM Cognos Connection unless

your system administrator has given you permission to do so.

Now that you have saved the report, you can open it again later with Query Studio to change it or

make it available to other users who can view and print it from the IBMCognos Connection portal.

For more information about how to use Query Studio, see the Query Studio User Guide and quick

tour available from the Help menu.
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Creating a report with Report Studio
You can use Report Studio to modify the report that you created and saved in the last section or

to create a more sophisticated report. Report Studio allows you to create reports with more complex

layout, formatting, and report user interactions. The following steps provide an overview of some

of the features available in Report Studio.

❑ Open Report Studio.

On the IBM® Cognos® Express® Welcome page, click Create professional reports with Report

Studio. When prompted, select the same package that you used in the previous exercise, and

then clickOpen an existing report or template. Choose the Query Studio report that you already

saved. Alternatively, if you still have the Query Studio report open, from theManage Filemenu

on the left side of the Query Studio screen, select Open in Report Studio.

❑ Change the list to a crosstab.

You can represent your report data in a crosstab instead of a list. Select a cell in the list report,

and click the pivot list to crosstab button .

❑ View objects that you can insert in your report.

At the bottom of the Insertable Objects pane, click the Toolbox tab . From here, all the

objects that you can insert into your report are available, such as calculations, filters, prompts,

and layout objects. With these objects, you can add additional business logic and sophisticated

formatting to the report.

❑ Run the report.

On the toolbar, click the drop-down arrow beside the run report button . Here you will

see a variety of options for viewing the report. Click Run Report - PDF. If you added prompts
to your report, you are asked to enter values in your prompt before you can view the report.

Your report opens in PDF format, which is suitable for printing and saving for distribution to

other users.

❑ Save the report.

To save your report, click the save button . Provide a name for your report and select a

location in IBM Cognos Connection. Save your report in Public Folders to make it available

to others. Save it inMy Folders to make it available only to you. To change the default location,

click Select another location.

Tip: By default, you cannot save reports at the top level of IBM Cognos Connection unless

your system administrator has given you permission to do so.

Report Studio provides you with all of the capabilities that you need to create highly formatted

reports which can be distributed to end users through a variety of options.

For more information about how to use Report Studio, see the Report StudioUser Guide and quick

tour available from the Help menu.
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View content in IBM Cognos Connection
Launch IBM Cognos Connection from the IBM® Cognos® Express® Welcome page and navigate

to the locations where you saved the reports that you created in this chapter. Beside each report is

a list of Actions that you can perform, such as running the report in different formats, scheduling

the report to run at a later time, and opening the report in Query Studio or Report Studio for further

authoring. For more information about using IBM Cognos Connection, see the IBM Cognos Con-

nection User Guide.

If your IBMCognos Express administrator has installed and configured the samples that come with

the product, you will see a Samples folder in Cognos Connection that contains predefined Query

Studio and Report Studio reports. To view these reports, click Samples >Models and then select

one of the blue GO Sales folders to see the content that is available. You can run these reports by

clicking on them, or open them in Query Studio or Report Studio to examine how each was created.

The sample reports provide you with examples of the types of features that are available in the

product and how you can use these features to design and format your own report. Within these

reports, you will find examples of how you can use charts, dynamic prompts, and the drill-up and

drill-down features that can help to focus a report and provide real business value to yourself and

other users.

Tutorial - Report Studio and Query Studio
The following tutorials require that your IBM Cognos Express administrator has installed and

configured the samples package that is included with the product.

Tutorial - querying a package in Query Studio

Steps

1. Navigate to theWelcome to IBM Cognos Express page, log on with your user name and pass-

word when prompted, and then click OK.

2. Click Query my business data with Query Studio.

3. Under the list of packages, click Samples >Models > GO Sales (query).

4. In Query Studio, under the Insert Datamenu, expand the Inventory (query) folder, then expand

the Inventory, Branch, Product, and Time folders.

5. From the Time folder, drag and drop the Year column into the blank report window in the

middle of the page.

6. From the Product folder, drag and drop the Product line column onto the report to the right

of Year.

7. From the Product folder, drag and drop the Product type column onto the report to the right

of Product line.

8. From the Inventory folder, drag and drop the Quantity Shipped column onto the report to the

right of Product type.
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9. Within the report, click the Year title to highlight it, then select the Group button . Repeat

this action with the Product line column.

10. Right-click on any number in the Quantity Shipped column and select Format Data. In the

window that appears, set the Category to Number, the Number of decimal places to 0 and the

Thousands Separator to Yes, then click OK.

The data in the column is formatted accordingly.

11. Click the Chart button at the top of the screen to add a chart. Select Pie as the Chart type

then click OK.

A chart for each year is added to the report.

12. Click on the Title of the report to change the name and type Quantity by Product Type in the
title box, then click OK.

The new title is reflected at the top of the report.

13. Click the Save button. TypeQuantity by Product Type in theName dialog box and click Select
My Folders. Click OK.

The report is now saved to the Cognos Connection portal on theMy Folders tab.

You can find other tutorials for Query Studio by clicking the Quick Tour button at the bottom of

theWelcome to IBM Cognos Express page. For more information about using Query Studio, see

the Query Studio User Guide by clicking the Help link in Query Studio.

Tutorial - reporting on a package in Report Studio

Steps

1. Navigate to theWelcome to IBM Cognos Express page, log on with your user name and pass-

word when prompted, and then click OK.

2. Click Create professional reports with Report Studio.

3. Under the list of packages, click Samples > Models > GO Sales (query).

4. In theWelcome dialog, select Create a new report or template.

5. Select the List report from the list of available templates, then click OK.

6. In Report Studio, expand the Sales target (query) folder, then expand the Sales target, Product,

Retailer, and Sales staff folders.

7. From the Sales staff folder, drag and drop the Sales region column into the blank report window
in the middle of the page.

8. From the Retailer folder, double-click the Retailer site column to add it to the list report.

9. From the Product folder, double-click the Product line column to add it to the report.

10. From the Sales target folder, double-click the Sales target measure to add it to the report.
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11. Highlight the Sales region column title in the report and then click the Section button at the

top of the page.

12. Click the Retailer site column title to highlight it and then click the Pivot list to crosstab button.

This will convert the list report into a crosstab.

13. From the Product folder in the Insertable Objects pane, drag the Product type column beside

Product line in the report to nest it.

14. Click the Filter button. Click the Add button at the bottom left hand corner of the dialog box,

then under Available Components, select the Data Items tab to view the data that has already

been added to the report.

15. Double-click Sales region to add it to the Expression Definition. Then beside it in the Expression
Definition type = '?Sales Region?'. Click OK to close the Detail Filter Expression box, then

click OK to close the Filters dialog box.

16. Double click the text Double click to edit and type Sales Target by Region in the text box that
appears, then click OK.

The report title is updated.

17. Run the report by clicking the Run button. The prompt for Sales Region that was created in

the last step is displayed. Select a value from the drop-down box, for example Americas, then

click OK.

The report is displayed.

18. Select the View button at the top of the screen and from the drop-down box, select View in

PDF format.

The report is shown in this output. Close the PDF report.

19. In Report Studio, select File > Save As. In the Save As dialog box, selectMy Folders, then type

a name for the report, for example Sales Target Report, and click Save.

20. Close Report Studio.

21. View theMy Folders tab in Cognos Connection.

The new report that you created appears. You can run it from this location or save it to a folder

on the Public Folders to make it available to other users of IBM Cognos Express Reporter.

This tutorial on Report Studio provided information on just a small number of the features that

are available within the product to create sophisticated reports for your business. You can find

other tutorials for Report Studio by clicking the Quick Tour button at the bottom of theWelcome

to IBM Cognos Express page.

For more information about using Report Studio, see the Report Studio Professional Authoring

User Guide or the Report Studio Express AuthoringUser Guide by clicking theHelp link in Report
Studio.
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Chapter 6: Getting started with spreadsheet-based
analysis

IBM®Cognos® Express®Xcelerator extends yourMicrosoft® Excel worksheets into multidimensional

data structures using the IBM Cognos Analytic Server (ICAS). ICAS organizes your data into mul-

tidimensional database objects such as cubes, dimensions, hierarchies and rules that represent your

business model. This combines the power of multidimensional data with the formatting and user

interaction capabilities of Excel spreadsheets.

You can work with your business data directly in a Microsoft Excel spreadsheet, in a proprietary

Cube Viewer, or by using the Xcelerator web client. When you use Xcelerator, no physical data or

business calculations are stored in the spreadsheet, instead, they are all stored on the centralized

ICAS.

The Express spreadsheet-based analysis tools - Xcelerator and
Xcelerator client

IBM® Cognos®Express® contains two tools for performing multi-dimensional analysis.

❑ IBM® Cognos® Express®Xcelerator allows you to view cubes and spreadsheets in a Web

browser.

❑ IBM® Cognos® Express®Xcelerator client allows you to view and modify data stored in Xcel-

erator cubes while working in a familiar Microsoft® Excel environment.

IBM Cognos Analytic Server overview
The IBMCognos Analytic Server (ICAS) manages the database objects that make up any Xcelerator

application. The three primary object types are:

● Cubes: These represent a multidimensional data structure that manages business data and
contains the actual data values.

A spreadsheet has two dimensions; rows and columns. An Xcelerator cube can have up to 256

dimensions that can use meaningful business names like product, customer or scenario.

● Dimensions: Dimensions represent the outline or edges of a cube.

Xcelerator dimensions do not store actual data values, but define the shape of an Xcelerator

cube. Dimensions typically include a hierarchy of its members. For example, various products

rolling up into product groups, or customers rolling up into sales regions.

Once you have defined a dimension in Xcelerator, you can re-use it in as many cubes as you

wish. If you change the dimension by adding or deleting members or modifying hierarchies,

those changes are automatically applied to every cube that uses that dimension.
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● Rules: Rules are custom calculations that can apply sophisticated business rules to your cube

data in order to model your business. For example, you can create calculations for pricing or

discounting, cost allocations, or cube-to-cube calculations.

Rules are similar to using formulas in a Microsoft® Excel spreadsheet, except a rule applies to

the entire cube, not just a single spreadsheet cell. An Xcelerator cube can have only one rule

object, but that rule can include as many rule statements as you need to fully define your business

calculations.

Rules are fully described in the IBMCognos Express IBMCognos Analytic Server Rules Guide.

Note: The ICAS database is named CXMD (Cognos Express Multidimensional Database). This

database is also used by other products within the IBM® Cognos® Express® product family. For

example, IBMCognos Express Advisor. The objects it creates can be recognized by the prefix CXA_.

Any objects you create manually within CXMD using Xcelerator should also use a similar recog-

nizable prefix, such as CXL_. Do not modify or delete any objects that you do not recognize, as

they will likely be required by other Express users.

Tutorial - Xcelerator and Xcelerator client
The topics in this tutorial describe how to perform two common tasks in Xcelerator: creating a

cube and viewing a cube. The tutorial uses the sample data that is included with Xcelerator, which

contains over 20 pre-defined dimensions.

For complete details on creating and maintaining Xcelerator objects, including dimensions and

cubes, please refer to the IBM Cognos Express Xcelerator Developer Guide.

Tutorial - creating a cube in Xcelerator client
AnXcelerator cube must contain at least two dimensions and can contain as many as 256 dimensions.

For this example, you create an Xcelerator cube with four dimensions that define the products your

company sells through various channels across all months in a year. The cube uses the following

dimensions:

● Months

● Sales Plan Measures

● Channels

● Products

The final dimension, Sales PlanMeasures, may not seem like an obvious choice. However, a separate

measures dimension gives your Xcelerator cubes the ability to adapt to change in the future.

Including a measures dimension in every cube means that you can simply add additional measures

to that dimension as your business requirements evolve.

Steps

1. Click Start, All Programs, IBM Cognos Express, Xcelerator Client.

2. If a macro security warning appears, click Enable Macros.
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The Xcelerator add-in to Excel will not work if you disable macros.

3. Click CXL, Xcelerator on the Excel menu bar.

4. In the Server Explorer, click the + next to Servers to reveal the IBM Cognos Analytic Servers

that are available on your network.

5. Double-click cxmd.

6. On the login screen, enter your User ID and Password, then click OK.

7. In the Server Explorer, right click Cubes, then click Create New Cube.

The Creating Cube dialog box appears.

8. In the Available Dimensions list, double-click each of the following dimensions, in order:

● Months

● Sales Plan Measures

● Channels

● Products

The dimensions are added to the Dimensions in new Cube list.

Note: If you make a mistake, click the Reset button to start over.

9. After selecting your dimensions, click in the Cube Name field and enter Tutorial Cube as the

cube name.

10. Click Create Cube.

11. In the Server Explorer, click the + next to the Cubes group to reveal all the cubes on the server.
Tutorial Cube should appear in this list of cubes.

Tutorial - viewing a cube in Xcelerator
You can view your new cube in the Xcelerator web component.

Steps

1. On the IBM Cognos Express Welcome Page, clickManage my business performance with

Xcelerator.

2. In the Xcelerator window, click Views.

3. Click Tutorial Cube.

4. If there were defined views associated with Tutorial Cube, they would appear beneath the cube

name. Because there are not yet views for this cube, click New View.

The Xcelerator View Builder appears.
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The View Builder lets you configure a view by setting the location of dimensions in the view.

The IBM Cognos Express Xcelerator Web User Guide includes a full description of creating

views with the View Builder. For this tutorial, you can accept the default view configuration.

5. Enter a name for the view in the View Name box.

6. Click Save and View.

7. The view opens in Xcelerator. If the view displays a No Values Available message, click the

Suppress Zeroes button to reveal the data grid in the view.

8. The new view appears with its default configuration. There is a single row dimension, Channels.

There is a single column dimension, Products. There are two context dimensions, Months and

Salary Plan Measures.

Because this is a new cube and you have not entered or imported any data, all values are set to

zero.

You can re-arrange the dimensions to suit your needs and preferences by dragging and dropping

them within the Xcelerator window.

For example, you may want to:

● Put the Months dimension in the column area for a traditional annual budget collection

perspective.

● Put more than one dimension on the rows or columns. This is called stacking, and allows

you to compare large amounts of information in a concise format.

● Move dimensions to the title dimension area of the Cube Viewer window. Title dimensions

are grouped above the data grid in the Cube Viewer.

Be sure to click the Recalculate button after you rearrange the dimensions in the Cube Viewer.

9. Click the + next to a member in a row or column dimension to expand or collapse the dimension

hierarchy.

10. Click the drop-down menu on a title dimension to select a new dimension member.

Experiment with navigating and expanding the hierarchies to view leaf-level cells. Leaf-level cells

display without bold font, indicating that the cell is editable. Only leaf-level cells are editable in an

Xcelerator cube.

For more information about working with cubes and dimensions in Xcelerator, see the IBMCognos

Express Xcelerator User Guide and IBM Cognos Express Xcelerator Developer Guide.
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Tutorial - viewing a Websheet in Xcelerator
A Websheet is a Microsoft® Excel worksheet with IBM® Cognos® Express® Xcelerator data that

you can view in a web browser. By publishing an Excel spreadsheet to an application folder on an

IBM Cognos Analytic Server, Xcelerator users can view the spreadsheet in a Web browser.

Steps

1. On the IBM Cognos Express Welcome Page, clickManage my business performance with

Xcelerator.

2. In the Xcelerator window, click Applications, Great Outdoors, Sales Analysis, Sales_Fore-

cast3.xls.

AWebsheet titled 'Great Outdoors'opens. This Websheet is part of the Xcelerator sample data.

It includes formatting to make the report easier to read, and has been configured so that users

cannot modify the location of dimensions in the report.

For full details on working with Websheets, see the IBM Cognos Express Xcelerator Web User

Guide

Tutorial - viewing a cube in Xcelerator client
You can also view Xcelerator cubes directly in Microsoft® Excel using the Xcelerator client. This

example shows you how to export a cube view from the Cube Viewer to Excel using the Active

Form feature of Xcelerator. In practice, your IBM® Cognos® Express® administrator will likely

make a number of Active Form spreadsheets available on your IBM Cognos Analytic Server.

Steps

1. If necessary, click + next to the Cubes group to reveal all the cubes available on the IBM®

Cognos® Analytic Server.

2. Double-click the Tutorial Cube.

3. In the Cube Viewer, click the Recalculate button on the toolbar.

4. Click File, Active Form.

The cube opens in a new Excel worksheet. Unlike the Cube Viewer, you cannot rearrange the

location of dimensions in an Active Form, but you can expand/contract dimension hierarchies

and select different title dimension members.

5. Double-click Total Products on the column dimension to expand the dimension hierarchy.

6. Double-click Camping Equipment on the column dimension to reveal the child members of

Camping Equipment.

7. Dcouble-click All Channels on the row dimension to expand the dimension hierarchy.

8. Double-click Total Year on the Months title dimension.

The Subset Editor appears.

9. Click Jan, then click OK.
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The Active Form now includes a number of cells without any shading. These cells are editable.

10. Enter a numeric value in the cell at the intersection of Outdoors Shop and Cooking Gear.

11. Enter a numeric value in the cell at the intersection of Warehouse Store and Cooking Gear.

12. Press F9 to recalculate the Active Form. Note that the Total Products and Camping Equipment
values update to reflect the values you entered.

You can experiment with entering additional values in the spreadsheet.

13. On the Excel menu bar, click CXL, Save Workbook on Server, Upload New Application File

to Server.

The Select an Xcelerator Application Folder dialog box appears.

14. Double-click cxmd, then double-click Applications, then double-click Great Outdoors.

15. Click the Sales Analysis folder, then click OK.

The Active Form spreadsheet is now saved as a file in the Sales Analysis folder under the

Applications group on the cxmd server. You can double-click this file to view the cube data in

the Xcelerator client.

16. To view the spreadsheet as a Websheet in Xcelerator, start Xcelerator, then click Applications,

Great Outdoors, Sales Analysis, then click the file name.
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Chapter 7: Getting started with planning

IBM® Cognos®Express® Planner enables automated planning, budgeting and forecasting. Financial

planners can create centralized planning models and users throughout the organization can make

template-driven plan contributions on a continuous basis.

The Express planning tools - Planner Administrator and Planner
Contributor

IBM® Cognos®Express® Planner contains two tools.

❑ IBM®Cognos® Planner Administrator allows you to transform your existing planning, budgeting

or forecasting model into a structured planning application.

❑ IBM® Cognos® Planner Contributor allows you to contribute to a planning application in a

structured environment.

Tutorial - Planner
In the IBM® Cognos®Express® Planner tutorial you use samples. To install the samples, see the

Managing IBM Cognos Express guide, Setting up the IBM Cognos Express samples

To perform the steps in this tutorial you must be an Express Administrator.

Creating a contributor view and an approval subset
To use a planning model with IBM® Cognos®Express® Planner it needs to have one or more con-

tributor views which define the data entry sheets and also a dimension subset which defines the

approval hierarchy.

Steps

1. Start Express Architect.

2. Expand the Servers node.

3. Double-click cxmd and log on as administrator.

4. Expand the Cubes node.

5. Double-click the Price and Cost cube.

The Cube Viewer displays.

6. Drag and drop TOTAL PRODUCTS on Versions.

The Versions and Products dimensions are swapped.

7. Double-click Total Year and expand Q1. Then select Jan and click OK.
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8. Click Products.

The Subset Editor displays.

9. On the toolbar click the All icon .

10. On the toolbar click the Filter by Level icon .

The Filter By Level dialog box displays.

11. Select level 0 and click OK twice.

12. Click Price and Cost Measures.

The Subset Editor displays.

13. Hold the Ctrl key and click Unit Sale Price and Unit Cost and click OK.

14. On the tool bar click the Recalculate icon .

15. Click File> Save as and save the view as a public view (clear the Private option) called Unit
Price and Cost.

16. Close the Cube Viewer.

17. Expand the Dimensions node.

18. Double-click on the Channels dimension.

The Subset Editor is displayed.

19. From the Subset menu click Save As and save it as a public subset (clear the Private option)
called elist.

20. Close the Subset Editor.

Design a planning application
Planning applications are maintained in IBM® Cognos®Express® Planner Administrator which can

be accessed from the planning applications home page. Designing a planning application consists

of defining which views are to be used by contributors, defining what dimension subset will be the

approval hierarchy, deploying the application and finally defining the security. Note that although

security is a key part of a planning application, it's included here mainly for demonstration purposes

as the tutorial application will only have a single user.

Steps

1. From the Launch menu in Express Manager, click Planner.

2. On the toolbar, click the Design an Application icon .

IBM Cognos Express Planner Administration is launched.

3. On the toolbar click the New icon .

4. In the Application Name field type Price and Cost.
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5. Click OK.

6. In the ICAS Objects tree at the bottom left of the screen, click Cubes > Price and Cost > Views.

7. Right-click on the Unit Price and Cost view and select Add to Application.

8. In the ICAS Objects tree at the bottom left of the screen clickDimensions > Channels > Subsets.

9. Right-click on the elist subset and click Add to Application.

10. On the toolbar click theValidate icon and then click OKwhen a message appears confirming

the application was validated successfully.

11. On the toolbar click the Save icon .

12. Specify a file name and click Save.

13. On the toolbar click the Deploy icon .

14. When a message appears confirming the application was successfully deployed, then clickOK.

15. On the diagram depicting the four main parts of designing a planning application, click on the

Define button in the Define Security section to open theManage Rights page.

16. In the 1. Add Rights section select node Golf Shop.

17. In the 2. Select Group section select Cognos\Express Users.

18. In the 3. Define Security section from the Right menu select Submit and click Add.

19. On the toolbar click the Save icon and then click Close when a message appears confirming
that the rights are saved successfully.

20. Close theManage Rights page and return to the planning applications home page.

Activating a planning application
You must activate the planning application to make it available to IBM Cognos Express Planner

users.

Steps

1. On the IBM Cognos Express Planner home page click the Refresh icon .

The newly created planning application Price and Cost displays.

2. On the right of the Price and Cost application, click the Activate Application - Price and Cost
icon to activate the application.

The planning application is available.

Using a planning application
You can contribute to a plan or budget and review submitted contributions.
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For more information on how to maintain and use planning applications, see the IBM Cognos

Express Contributor User Guide.

Steps

1. On the planning applications home page click the Price and Cost link.

The Price and Cost planning application displays.

2. Click Golf Shop.

The contributor page of the Golf Shop node displays.

3. On the toolbar click the Take ownership icon .

4. In the Context section select Budget Version 3 for the Versions dimension and then click the

Recalculate icon .

5. Enter data in the cells by typing values or by using any other method available for entering

data in web sheets.

6. On the toolbar click the Submit icon and click Yes when asked to confirm submitting Golf

Shop.

7. Close the contributor page for the Golf Shop node and verify the state of this node is now

Locked.
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